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With the help of this Technical Note we will demonstrate how to create an SDfile that will list
specific information about products created using an MDL® Afferent™ library. Then, we will
calculate retention times and show the suggested method within ACD/ChromGenius Batch [1] for
all the structures from an SDfile.

Preparing an SDfile

Note You must use the latest version of MDL Afferent, 3.0 SP2, in order to successfully
complete this procedure.

1. Openyour MDL Afferent Database and create a Library that contains precursors and a
reaction.


http://www.chromgeniusbatch.com/
http://www.acdlabs.com/
http://www.mdl.com/
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2. Click the Products tab. From the Operations menu, choose Enumerate product data.
A new dialog box appears:

Enumerate produck d =10 x|

[ Save product info in the databaze
[ Dizplay products on the screen as a chart
[T Export products as an 50 file

[~ “Wiite non-structural data to a tab-delimited file

[ Arimate enumeration

E nurmerate data | Advanced | Cancel |

3. Select the Save product info in the database check box and click Advanced. After the
dialog box is expanded, select the Enumerate contaminants check box:

Enumerate product data for library =10 x|

¥ Save product info in the databaze
[ Dizplay products on the screen as a chart
[~ Export products as an 5D fils

[T wiite nom-structural data to a tab-delimited file

[~ Arimate enumeration

[T Always show advanced options

V¥ Enumerate contaminants

[ Use reaction product geometries for product molecules

Select precurzor combinations:

% from library layout [generated automatically if required)

™ all possible combinations [ho layout uzed; good for large libraries]

" arandom sample of combinations [no layout used; good for huge libranies)

Enumerate data | Cancel |

Note Doing the SDfile export during enumeration will not provide the desired information.
Instead, the samples must be exported AFTER enumeration is completed.
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4. Click Enumerate data. Click OK when the enumeration is done:

Il Product enumeration El

\lj) Library produck data written.

5. To view the contaminant status, on the Products tab, select the Show contaminants
check box. Make sure the well of interest is highlighted:

Library 2x2 amides in ..."amide libraries 10 x|
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6. Close the library.
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7. Inthe Afferent Explorer dialog box, on the File menu, point to Export, and then choose

SD (.sdf) file.
| File Edit “iew Synthesis Options ‘Window  Help
Mew b Htabaze Bl 242 amides
Import b ([ 242 amides_products
Export Afferent package (,apk) file. ..
i i Molecules)samples to ISIS/Host. . _products
Reload weights files ) '
Tnstall i ke Reactions as RD {.rdf) file. ..
nskall new license key. .. 5D { 5df) file..,
Exit Lk File. ..
— L [
(L Example libraries ) HSbeH1_
(2 thioureas library_products lﬂ] simple amides
[ Tutorial Work Area (2 simple amides_products
[0 Utilities
JI[JEN

8. You will see a new Export SD file dialog box. Click Browse and specify the name and
location of your SDfile:

=

Drag and drop the molecules and/or zamples bo expart:

SO file b write:

C:MAfferent\SDFilesLibrary Marme. sdf Browse... |

Froperty map | 38 Property Map for ChromiG enius

E wport | Caricel |
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9. Place both dialog boxes, Export SD file and Afferent Explorer, next to each other for
convenience:

Export 5D file =] 4] Afferent - amide libraries in Afferent 3.05P1 Access Datak - 0] x|

[rrag and drop the molecules and/or samples to expart: File Edit “ew Synthesis Options Window Help
=B &l Afferent 3.QSF‘1 Access Database Mame | Type | Comment | =
S:% ﬁl;_t%mat?%h 242 amides Library
B Medi;:all-ch:r;n 2#2 amides_products |FOIder | |
B[] Stockroom curtiug amides Library
23 temp curtius amides_products |Folder
S Tutorial work Area R504107 M olecule
=51 amide libraries RS34198 Moleculs
[_1 benzodiazepines librany RSH5012 Molecule
D Example librariez R555991 Maolecule
[ thinureas library_praducts simple arnides Library
[ Tutorial ‘work Area simple amides_products |Folder
B[ Utiities
SD file to write:
C:\Afferent\SDFile'Library Marme. zdf ﬂ
Property map | 5% Property Map for ChromGenius
E xport | Cancel [
oo 1 I

10. Using the Afferent Explorer dialog box, navigate to the library products folder, which
was automatically generated during enumeration and can be found in the same folder as
the library itself.

11. From the View menu, choose Detail and then sort data by type:

=] | Afferent - 242 amides_products in Afferent 3.05P1 Acces: - 0] x|

Drrag and drop the molecules and/or zamples to export: File Edit Wiew Synthesis Options Window Help
=0 &l Afferent 3.QSF’1 Access Database Mame | Type | Camment | il

g:% puematon 149124 Molecule

$1—] Medicinal Chem 14925 B

E—( Stockioom 149126 Molecule

(1 temp 149127 Molecule

S Tutorial Wk Area 149128 Molecule

B amide libraries 145123 Molecule
{3 2w amides_products 24471 Sample
(2 curtiug amides_products 24472 Sample
[_ simple amides_products 24473 Sample
[_ benzodiazepines library 24474 Sample
[ Example libraries 24475 Sample
S0 file to wite: [C] thioureas libramy_products 24476 Sample
- — ﬂ 120 Tutorial work, Area 24477 S ample
|C.\.t’5\fferent\8 DFiletLibrary Mame. sdf B Utiities e Sample
24479 Sample
Praperty map % Property Map for ChromGenius 24480 Sample
24481 Sample
24482 Sample

Export | Cancel | -
.| [
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12. Select all of the samples in the folder, and either drag and drop, or cut and paste them
into the Export SD file dialog box. Do NOT include any molecule or mixture objects that
may also be in the folder.

_lolx

Drag and drop the molecules and/or zamples bo export:

24471 g 24482
24472
24473
24474
24475
24476
24477
24478
24479
24450
24481

CECECECECE R CE R TR R

SD file to write:
IE:"-.fl'-.fferent'\SDFiIe'\LiI:urar_l,l M arme. zdi ﬂ

Praperty map | <& Property Map for ChromG eniug

E wport | Cancel |

13. Right click the inside of the Property map field and choose [New].

Note A property map is used to relate fields in external files (such as SDfiles, RDfiles,
and tab delimited files) with Afferent properties. When you import or export such
| files, you can specify a property map to indicate how data in the Afferent database

is to be associated with the file data.
14. In a new window, specify a name for the map.

Name and folder for n 10| x|

"What would vou like to call the new property-map?

|Propertied

Falder for new property-map:

ol Afferent 3051 Access Database :I

15. Click OK.
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16. A blank Property map dialog box appears:

Property Map Properties in ...\ Afferent 3.05P1 Access Database — |EI|£|
File Edit Help
Map | Comments
Afferent properties Property <--»> Field Field
{1 4l properties 1 |First line of object record =
Sequential integers
=l =
4 [ 4 [v[
Map property to field | Import fields from SO file... |
Delete kMapping | Mew field name... | Delete field name |

17. Click + to expand the All properties folder:

Afferent properties

|:| All properties
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18. Then expand the Built in properties folder under the Molecule and Sample objects:

Afferent properties

Wl Library |

[ Built in properties

M ame

bolecular weight
Comment
Contarinant statu:
talecular formula
B[ Properties

Bg_ﬁ Sample
—H-(C ] Built in properties
—[E] Aray
—[E] Marme
—[E] Location
—[E] Metmass
—[E] Comment
—[E Precursars
—[E Vessel
—E] Purity
"] Inventary
(] SR

| | »]
19. For this example, we want to extract the Name and Contaminant Status fields from the

Molecule object and the Array, Location, Precursors, and Vessel fields from the
Sample object.

Note This property map shows the mappings necessary for creating an SDfile in MDL
Afferent that ACD/ChromGenius Batch will accept.

(] ) ) [ ]

Il

1

20. Click New field name ~ Mewfield name.. | In the new dialog box that appears, type
the Name and click OK to close this window:

[ [ Newficld -1of x|

Mame of the external field: INamEI

()% | Cancel |

21. Click New field name  Mew field name. . | again and create Contaminant status,
Array, Precursors, Vessel, and Location fields in the same manner.
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22. You will see all new fields appear in the Field section:

Field

Array =
Contaminant Status

First line of object record

Location

Mame

Precursors
Seguential ntegers
" esze

=
1| | v

23. Highlight Molecule > Name in the Afferent properties section and Name in the Field

section and click Map property to field Map property to field |to see the
following connection:

Property Map Property Map for ChromGenius in ...\ Tutorial Work Area _ 0] x|

File Edit Help

Map L

Afferent properties Praperty <--> Field Field

|»

|| Litrary d Malecule:Built in properties: N ame <--> Mame Array
Malecule Contarninant Statuz
1 Built in properties First line of object record

—E Lacatian

—E] Molecular weight
—E Eommept Precursors

&l Contaminant statu: Sequertial integers

—E] Molecular formnula (T

E—(_] Properties
Sample

1 Built in properties
—E Aray

—E] Mame

—E] Location
—E] Met mass
—E Comment
—E] Precursors
B Vessel

“—E] Purity
B0 Irwentany |
B 54R - = =l

« (2] S >

Map property to field | Import fields from SO file... |

Delete kMapping | Mew field name... | Delete field name |

|»

10
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24. Follow the same procedure for the rest of the created fields to complete the connection:
=lo0lx]

Property Map Property Map for ChromiGenius in ... Tutorial Work Area
File Edit Help

Map Ly

Afferent properties

Property <--> Field Field

|»

Molecule:Built in properties:Name <--» Mame 1= Array

11 Librany |

Malecule

1 Built in properties
—E] Mame

—E] Molecular weight

Molecule:Built in properties: Contaminant status <--» Conta
Sample:Built in propertiesVessel <> Vessel

Sample:Built in properties: Location <-» Location
Sample:Built in properties: Precursors <--» Precursors

Contarninant Status
First line of object record
Location

Marne

—E] Comment
—E Contarninant stahu:
—E Molecular farmula
E—[_] Properties
Sample
1 Built in properties
—E Aray
—E] Mame
—E] Location
—E] Met mass
—E Comment
—E Precursorz
B Vessel
“—E] Purity
B0 Irwentany ||
B S&R |

a | o 4] |

Precursors
Sequential integers
Wessel

Sample:Built in properties.anay <> Aray

pt
el

4| | »

Import fields from SO file... |

Mew field name... |

Map property to field |

Delete kMapping | Delete field name |

25. From the File menu, choose Save to save all the changes to the property map.
26. Close the property map by clicking Close .

27. Return to the Export SD file dialog box and click Export Expart |

Importing an SDfile

1. We are now ready to predict retention times and suggest the best method for the
structures in SDfile.

11
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=[]

Database Wiew Method Record Struckure Search  Lists  Plates Options ACDfLabs  Help

L [op O [ 40b I b, W v 5| & |G| G e |1
M1_C18 ~ ethod Paramete =

h1_CH

o thod N : M1_C1a
M1_HSC18 R
Wit _HEF3S Temperature: 35 °C
M2_C18
M2_CH chile Phase A:
M2 _HSC1 hd

obile Phase B:

obile Phase C: Water (100w/w); l0mM AcONH4; (pH 3)

obile Phase D: MeCN/Water (90:10w/v): lmM AcONH4: (pH 5)

Gradient: 0-0&4 0-0F 95-100C 5-0D (€min); O-04 0-0F 100-100C 0-0D (Ll.4min); O-04 0O-
t0: 0.7nin at Flow Rate: 0.2Zml/min

Inztrumental Wame: Waters Alliance

Column Name: Discowery C13

o o

LooP |f ohnd of Lists

[z ABTE BLETE | smsmoneEzzem | [ HRLC

Chem5Sk | Besults | History | Processor | CGDatabase |

3. The ChromGenius Batch database used for this example was kindly provided by
Supelco, Inc. It includes 12 methods.

4. On the Database menu, point to Tools, and then choose Calculate SDFile(s).

12
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5. Anew Calculate SDFiles in Batch Mode dialog box appears:

Calcutate SDfiles in Batch Mode x|
S Dfile —Output to Beport ——————————
—Method
{+ One Best Only
i~ Best |3
Al
Treat SDfile Az ﬂ'l al }(l : :
= Separate Structures Eredicted Properties
: L Suitability Coefficient
€ Single MIEFLI[E Retention tirme [tR), mirn
* Several Mistures | Retention Factor [k, min
Mixture [dentifier: IL-:u:atiu:un Options | L] Peak width
—Flace Results [nto
[~ iable [ SDille
SDfie |
Falder Hame : ISame as Source j |
[+ Usze Original Folder [+ EeepBackup Copy
[+ Sort Besults by Methods [~ Separate Dutput File far Each Method
g/ k. x Cancel | ? Help

6. Click Add File El and specify the location of the SDfile that you exported from MDL
Afferent. It will appear in the SDfiles area.

SDfile
“ D:AfferentsLibramy Mame. zdf

7. Click Several Mixtures and then click Options. Specify the following options. Type in
desired and contaminant in the fields for Main Compound and Impurity.

Complex SDfile Options |

—5Dfile Field far Misture |dentification
Mixture | dentifier: ILDcatiDn j

Load 50file Fieldz |

— Compound Statuz Option

¥ Extract Main Compound within bisture

SDfile Field Marme: IEDntaminant j

Field % alue for M ain Compound: Idesired j

Field *falue for Impurity: Il:l:untaminant j
& 0K X Cancel |

8. Click OK to close the Complex SDfile Options dialog box.

13
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9. Atthe end you should have the following:

Calcutate SDfiles in Batch Mode x|
S Dfile —Output to Beport ——————————
O *afferentsLibrary Mame. sdf —ethod
{+ One Best Only
i~ Best |3
Al
Treat SDfile Az ﬂ'l al }(l : :
= Separate Structures Eredicted Properties
: L S uitability Cosfficient
£ sl Mlﬁ_ture R etention time (1R, min
* Several Mistures | Retention Factor [k, min
Mixture [dentifier: IL-:u:atiu:un Options | L] Peak width
—Flace Results [nto
[~ iable [ SDille
SDfie |
Falder Hame : ISame as Source j |
[+ Usze Original Folder [+ EeepBackup Copy
[+ Sort Besults by Methods [~ Separate Dutput File far Each Method
g/ k. x Cancel | ? Help

10. Click OK to start the calculation.
11. After the calculation is completed, you will get a message:

Result of Calculation x|

D-MAfferentsLibrary Mame. zdf - Calculated

12. Click OK.

14
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13. You can open your SDfile with Notepad to see the additional fields: tR and a hame of
suggested method (M1_C18 in this case).

B Library Name.sdf - Notepad -10| x|

File Edit Format Yiew Help
-l

[

> <Contaminant statuss
desired

FoOCArr Ay
1

> <Location:
1:A01

- <MC_NMame_1:
vl _C18

$85%
145994

-
|4 | H 4

14. Note that you can also export the method choices in text form, omitting the chemical
structures. The result will look like this:

[P thioureas library.txt - Notepad - 10| =|

File Edit Farmat Yiew Help

complex sofile: sofile can contain mixtures -
Complex spfile options: Mixture Identifier - Location; Extract Main
Compound mZ_Mamea_1 suitability 1 trR_1 Caution

1 ML_C18 1 3.1488 Main Compound Status @ desired

1 ML_C18 1 5.6444 Main Compound Status @ contaminant

1 MLl 18 1 2.4131 main Compound Status : desired

2 MZ_HSF5 1 5.1987 Main Compound Status @ desired

el MZ_HSFS 1 4.5087 Main Compound status @ desired

2 MZ_HSFS 1 5.8501L Main Compound Status @ desired

3 M3_C18 1 3.0591 Main Compound Status @ odesired

3 m3_C18 1 2.5142 main Compound Status : desired

3 M3_C18 1 4.8531 Main Compound Status @ desired

1] | W

15
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Note When you place results into a table, all the fields from the SDfile are not
automatically transferred into the table. Click Report SDfile Fields

Beport SDfile Fields... | in the Calculate SDfiles in Batch Mode dialog box shown

below:
Calcutate SDfiles in Batch Mode X|
5D file —Cutput to Report

C:ADocuments and Settingssinna ACDDOMAD ezktophCon | | Method
{* One Best Only
i Best |2

Treat SDfile As | & %]

{ Separate Structures

. . S uitability Coefficient
" Single Ml;-ture Retention time [tR). min
f+ Several Mistures [] Retention Fachar [k, min

Mixture |dentifier; IL-:u:aticun Options | [] Peak Width

—Place Resultz [nto
v Table [~ SDfile

Predicted Fropertiez

Table |
Falder Hame ID:"-\.-'i‘-.fferent j |
[T Usze Original Folder [ KeepBackup Copy " Beport DIl Fiaids...

[¥ Sort Results by Methods [~ Separate Output File for Each Method

g’ ] | x Cancel | ? Help

15. You will see the Available fields that need to be used.

Place 5Dfile Fields to Table x|

Ayvailable Fields Fields to Lze

Array

Contaminant Status

Lacatian

M ame >

M arme from Header

Precurzars s Up

Wezzel —
£ Do
<4

x Cancel | ? Help

16
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16. Click ** to transfer all the fields at once in the Fields to Use section. You can sort
them by clicking Up  HUP | and Down DDW”l.
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